Configure Switched Port Analyzer on ACI
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Access SPAN (ERSPAN)

Casel. Src"Leaflel/11 el/34 & Leaf2 el/11" | Dst "192.168.254.1"
Case2. Src "L eafl €1/11 & L eaf2 €1/11" | Dst "192.168.254.1"

Case3. Src "L eafl 1/11 & | eaf?2 1/11 & EPGI filter" | Dst "192.168.254.1"

Access SPAN (L ocal SPAN)
Case . Src"Leafl el/11 el/34" | Dst "L eafl e1/33"

Case 2. Src "L eafl e1/11 el/34 & EPGI filter | Dst " Leafl €1/33"
Case3.Src"Leaflel/11 & Leaf2 €/11" | Dst "L eafl €1/33" (bad case)
Cased. Src"Leafl €1/11 & EPG3filter" | Dst "L eafl €1/33" (bad case]
Case5: Src "EPG1 filter" | Dst "L eaf1 €1/33" (bad case)

Case 6. Src"Leafl - Leaf2 vPC" | Dst "L eaf1 €1/33" (bad case)

Case7. Src"Leafl e1/11 | Dst "L eafl e1/33 & €1/33 belongs to EPG" (works with fault)
Tenant SPAN (ERSPAN)

Casel. Src "EPG1" | Dst "192.168.254.1"

Fabric SPAN (ERSPAN)

Casel. Src "L eafl €1/49-50" | Dst "192.168.254.1"
Case 2. Src "L eafl €1/49-50 & VRF filter" | Dst "192.168.254.1"

Case 3. Src "L eaf1 €1/49-50 & BD filter" | Dst "192.168.254.1"

What do you need on the SPAN destination device?
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ERSPAN Type | (used by Broadcom Trident 2)
ERSPAN Typell or 1]
ERSPAN Data Example
Tenant SPAN/Access SPAN (ERSPAN)
Details of Captured Packet (ERSPAN Type |)
Fabric SPAN (ERSPAN)
Details of the Captured Packet (ERSPAN Type 1)
How to Decode ERSPAN Type |

How to Decode iVXLAN Header

| ntr oduction

This document describes how to configure Switched Port Analyzer (SPAN) on Cisco Application Centric
Infrastructure (ACI).

Background I nformation

In general, there are three types of SPAN. Local SPAN, Remote SPAN (RSPAN) and Encapsulated Remote
SPAN (ERSPAN). The differences between these SPANSs are mainly the destination of copy packets. Cisco
ACI supports Local SPAN and ERSPAN.



Note: This document assumes that readers are already familiar with SPAN in general such as Loca
SPAN and ERSPAN differences.

SPAN Typein Cisco ACI
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@ Fabnc SPAN SPAN on Fabric ports on Spine or Leal e— ERSPAN (remote IP)

@ Tenant SPAN SPAN on EPG{=VLAN) on Leaf — ERSPAN (remote IP)

> ERSPAN (remote IP)

® Access SPAN  SPAN on Access ports on Leaf —
=3 Local SPAN (Local port)

5 Infra SPAN = Acoass SPAN

Cisco ACI has three types of SPAN; Fabric SPAN, Tenant SPAN and Access SPAN. The difference between each
SPANSs s the source of copy packets.

As mentioned previously,

* Fabric SPAN iSto capture packets that come in and go out from interfaces between L eaf and Spine switches.

* Access SPAN iSt0 capture packets that come in and go out from interfaces between Leaf switches and external
devices.

* Tenant SPAN IS t0 capture packets that come in and go out from Endpoint Group (EPG) on ACI Leaf switches.

This SPAN name corresponds to where to be configured on Cisco ACI GUI.

» Fabric SPAN is configured under Fabric > Fabric Policies
» Access SPAN is configured under Fabric > Access Policies
» Tenant SPAN is configured under Tenants > { each tenant}

Asfor the destination of each SPAN, only Access SPAN is capable of both Local sPAN and ERSPAN. The other
two SPAN (Fabric and Tenant) are only capable of ERSPAN.

Limitations and Guidelines

Please review the Limitations & Guidelines from Cisco APIC Troubleshooting Guide. It is mentioned
in Troubl eshooting Tools and Methodology > Using SPAN.

Configuration

This section introduces brief examples that relate to the configuration for each SPAN Type. There are
specific sample cases on how to select the span type in the later section.


https://www.cisco.com/c/en/us/td/docs/switches/datacenter/aci/apic/sw/1-x/troubleshooting/b_APIC_Troubleshooting.html

SPAN Configuration is also described in Cisco APIC Troubleshooting Guide: Troubleshooting Tools and
methodology > Using SPAN.

The Ul can appear different than the current versions but the config approach is the same.

Access SPAN (ERSPAN)

Sample Topology

Dst EPG 192.168.254.1

] _'—] Source Group l

Destination Group

vlan-751 vian-753

vlan-754 vian-755 vian-756

EAES
EPG3 EPG1

EPG1 EPG2

192.168.1.0/24 192.168.2.0/24

VMs to be captured

Configuration Example

SPAN Destination - DST i

SR

PROPERTIES

Dttt EP0: et T g SPAN_APP oy S

PR s Version 1

Dustition B- §4114.134.3

St B 1921 A
Fam 1
™ie

slietlle sy TEMANTS R

v o OPERATIONS i
sl ETWOR SRS ADMIN  OPERATIONS. £ i

ACCERS POLIES

W 1318

SPAN Source Group - SRC_GRP1 i
ormmanows | rears | vesromr
[of3 | cnos |

PROPERTIES | SPAN Version
M SRC_GRPY ERSPAN Type
Do ERSFPAN dst IP :
| — SPAN packet will be thrown to this IP. Need to be learned as EP in Dst EPG.
" EE ERSPAN src IP :
192.168.254.254 : every Leaf use this
192.168.254.0/24 : each Leaf use it's own node id { ex. 192.168.254.101)

P Ungpectied

DESTINATION GROUPS

SPAN Source - SRCL i

[ oo |
(]3] [ acrioess - |

PROPERTIES
P SAC

Direction :

Both / Incoming / Outgoing
Source EPG

Option. When you need EPG(VLAN) filter.
Source Paths :

MNormal part, PC, vPC

Where:

Navigate to FABRIC > ACCESS POLICIES > Troubleshoot Policies > SPAN.


https://www.cisco.com/c/en/us/td/docs/switches/datacenter/aci/apic/sw/1-x/troubleshooting/b_APIC_Troubleshooting.html
https://www.cisco.com/c/en/us/td/docs/switches/datacenter/aci/apic/sw/1-x/troubleshooting/b_APIC_Troubleshooting.html

® SPAN Source Groups
® SPAN Destination Groups

SPAN Source Group ti€S Destination and Sources.
How:

1. Create SPAN Source Group (SRC_GRP1).
2. Create sPAN Source (SRC1) under sPAN Source Group (SRC_GRP1).
3. Configure these parameters for sPAN Source (SRC1).

- Direction - Source EPG (option)

- Source Paths (could be multiple interfaces)

Note: Please refer to the picture for details of each parameter.

4. Create SPAN Destination Group (DST_EPG).
5. Create SPAN Destination (DST).
6. Configure these parameters for SPAN Destination (DST)
- Destination EPG
- Destination IP
- Source IP/Prefix  (This can be any IP. If the prefix is used, node-id of the source node is used for
the undefined bits. For example, prefix: 1.0.0.0/8 on node-101 => src |P 1.0.0.101)



- Other parameters can be left as default

Note: Please refer to the picture for details of each parameter.

7. Ensure the spPAN Destination Group S tied to an appropriate SPAN Source Group.
8. Ensure Admin Stateis Enabled.



Note: SPAN stops when you select Disabled on this Admin State. There is no need to delete
all policiesif you re-use them later.

Also please ensure that the destination IP for ERSPAN islearned as an endpoint under the specified
destination EPG. In the previously mentioned example, 192.168.254.1 has to be learned under Tenant TK >
Application profile SPAN_APP > EPG SPAN. Or the destination I P can be configured as a static EndPoint under this
EPG if the destination device is a silent host.

Access SPAN (L ocal)

Sample Topology



DST: i g s 111 _—| 1M1
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SRC.EPG1
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Configuration Example

SPAN Destination - DST

lllhllcl'» NSTEM  TEMANTS  FABRC 'l L ADMS  OPERATIONS come. i E

KNG SERMWCES.

— PROPERTIES
SPAN Source Group - SRC_GRP1 i T
-o wt r - -
el [ o e e C
e
PROPERTIES -
Lt DESTINATION ACCESS PATH

p— [ oestination pah: Wode-101/eth1/33 )

Sdton STe ) Do
8 P

DESTINATION GROUPS

SPAN Source - SRC1

e = BIE]

- PROPERTIES
i SRC1
Dscriphion:

i

Durecon; Bot %

SOURCES —|_)
any et Lp— [ ———

Sourte EPG: | ura/tn TR/ s0-SPAN_A9P s EPGL

Node 10BN

Hode 1R

* Where:
Fabric > ACCESS POLICIES > Troubleshoot Policies > SPAN
- SPAN Source Groups
- SPAN Destination Groups

SPAN Source Group ti€S Destination and Sources.

e How:

1. Create SPAN Source Group (SRC_GRP1)
2. Create sPAN Source(SRC1) under sPAN Source Group (SRC_GRP1)
3. Configure these parameters for sPAN Source (SRC1)

- Direction

- Source EPG  (option)

- Source Paths  (could be multiple interfaces)

X please refer to the picture for details of each parameter.
4. Create SPAN Destination Group(DST_L eaf1)
5. Create SPAN Destination(DST)
6. Configure these parameters for SPAN Destination (DST)




- Destination interface and node.
7. Ensure the SPAN Destination Group S tied t0 an appropriate SPAN Source Group.

8. Ensure Admin State iS Enabled.
% SPAN stops when you select Disabled on this Admin State. There is no need to delete all
policies if you re-use them later.

The destination interface does not require any configuration by Interface Policy Groups. It works when you
plug a cable into the interface on ACI Leaf.

Limitations;

» For Local SPAN, adestination interface and source interfaces must be configured on the same Leaf.

» The destination interface does not require it to be on an EPG aslong asit is UP.

* When the virtual Port-Channel (vPC) interface is specified as a source port, Local SPAN cannot be
used
However, thereis aworkaround. On afirst-generation leaf, an individual physical port that isa
member of vPC or PC can be configured as a SPAN source. With this Local SPAN can be used for
traffic on vPC ports.
This option, however, is not available on a second-generation leaf (CSCvc11053). Instead, support for
SPAN on "VPC component PC" was added viaCSCvc44643in 2.1(2e), 2.2(2€) and forward. With this,
any generation leaf can configure a port channel, which is amember of vPC, asa SPAN source. This
allows any generation leaf to use Local SPAN for traffic on vPC ports.

» Specifying the individual ports of aport channel on second-generation leaves cause only a subset of
the packets to be spanned (also due toCSCvc11053).

» PC and vPC cannot be used as the destination port for Local SPAN. From 4.1(1), the PC can be used
as adestination port for Local SPAN.

Access SPAN - With ACL Filters

Y ou can use ACL filters on access span sources. This feature provides the ability to SPAN a particular flow
or flow of traffic in/out of a SPAN source.

Users can apply the SPAN Acl(s) to a source when there is aneed to SPAN flow specific traffic.

It is not supported in Fabric SPAN and Tenant Span source groups/sources.

Care must be taken when you add filter entriesin afilter group since it could add tcam entries for every
source that currently uses the filter group.

A Filter Group can be associated to:

-Span Source: the filter group is used to filter traffic on ALL interfaces defined under this Span Source.
-Span Source Group: the filter group (say x) is used to filter traffic on ALL interfaces defined under each of
the Span Source(s) of this Span Source Group.

In this configuration snapshot, the filter group is applied to the Span source group.


https://tools.cisco.com/bugsearch/bug/CSCvc11053
https://tools.cisco.com/bugsearch/bug/CSCvc44643
https://tools.cisco.com/bugsearch/bug/CSCvc11053
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In the case where a particular Span Source already associates with a Filter Group (say Y), that filter group
(y) isused instead to filter group on al interfaces under this specific Span Source

- A Filter group that is applied at a source group automatically appliesto all sourcesin that source group.

- A Filter group that is applied at a source is applicable to that source only.

- A filter group is applied at both the source group and a source in that source group, the filter group applied
at the source takes precedence.

- A filter group applied at a source is deleted, filter group applied at the parent source group is automatically
applied.

- A filter group applied at a source group is deleted, it is deleted from all sources currently that inherit in that
source group.

Tenant SPAN (ERSPAN)

Sample Topology
3 ERSPAN only
# EPG(=VLAN) filter on whole Leaf
[C EPG . |- { ) % No Interface filter
. SPAN SRC :
Dst EPG 192.168,254.1 SPANSRC vian-756
vian-751, 752
Destination Group _‘—-—-I Source Group
Vian-753 75 18n-756
‘\E(', 4 3 “5
WMs to be captured EPG1

Configuration Example
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* Where:
Tenants > { tenant name} > Troubleshoot Policies > SPAN
- SPAN Source Groups

- SPAN Destination Groups
% SPAN Source Group ties Destination and Sources.
e How:

1. Create sPAN Source Group (SRC_GRP)

SPAMN Destination - DST_A

PROPERTIES
Hiime: BST_A
Dwseripiion:

——3 DESTINATION EPG
Destnation EPG: wnlftn-TK[ ap-SPAN_APP/epg SPAN
SRl Verson: Version 1
Destination IP: (910680541
Seurce BfPeefie: 197 168.294.0/24 [*
Fowm: 1 = | Same as Access SPAN
TIL: 64 &
MTU: 118
OSCPT Uariped find

SPAN Source - SRC_A

PROPERTIES
Hame; SRC_A
Description:

Diraction: | Both ot
Seairce EPG! | wniftn-TK ap-SPAN_AFR epg-EPG]1

Direction :

Both f Incoming / Qutgoing
Source EPG :

SPAN source EPG,

(appropriate VLAN sources are automatically configured on each Leaf)
(Source Paths cannot be configured)

2. Create sPAN Source (SRC_A) under sPAN Source Group (SRC_GRP)

3. Configure these parameters for sPAN Source (SRC_A)
- Direction
- Source EPG
X Please refer to the picture for details of each

4. Create SPAN Destination Group (DST_GRP)
5. Create SPAN Destination (DST_A)

parameter.

6. Configure these parameters for SPAN Destination(DST_A)

- Destination EPG

- Destination |P

- Source | P/Prefix

- Other parameters can be left as default

X Please refer to the picture for details of each

parameter.

7. Ensure SPAN Destination Group 1S tied to an appropriate SPAN Source Group.

8. Ensure Admin State iS Enabled.

% SPAN stops when you select Disabled on this Admin State. There is no need to delete all

policies if you re-use them later.



Fabric SPAN (ERSPAN)

Sample Topology

Destination Group

Dst EPG 182.168.254.1

R —

X 192.168.254.1

_—| Source Group l

Configuration Example

LLa] SPAN Source Group - SRC_GRP

PROPERTIES
Rame: SRE_GEP
Cusirgnen:

Admin St ) Brabled
| & Emabled

DESTINATION GROUPS

SPAN Destination - DST_A

[l

PROPERTIES
Hame: DST_A
Dorighion: o

DESTINATION EPG
Destnatien EPG: uniftn-

Testnaoon I 192, 169.004.1
Source BiPrefi: | 192.168.25400(24
Fleaw 10 3
T &4
HTU: 1518
DSCP: Uripeified

€ 0 4

SPAN Version (ERSPAN Type) : 2
Others are same as Access SPAN

SPAN Source - SRC_A

S0UBCE PATHS

Mo LU L, R BT

[

PROPERTIES
L

Descriphion:

« Where

Fabric > FABRIC POLICIES > Troubleshoot Policies > SPAN

- Fabric

- SPAN Destination Groups

¥ SPAN Source Group ti€S Destination and Sources

e How:

1. Create sPAN Source Group (SRC_GRP)

B B3 et 49

e LAY eth1 /%0

=

Direction :
Both / Incoming / Outgoing
Private Metwork / Bridge Domain :

Either of them. Filter packets on Fabric ports with specific VRF/BD




2. Create sPAN Source (SRC_A) under sPAN Source Group (SRC_GRP)
3. Configure these parameters for sPAN Source (SRC_A)
- Direction
- Private Network  (option)
- Bridge Domain  (option)
- Source Paths (could be multiple interfaces)
X please refer to the picture for details of each parameter.
4. Create SPAN Destination Group (DST_GRP)
5. Create SPAN Destination (DST_A)
6. Configure these parameters for SPAN Destination (DST_A)
- Destination EPG
- Destination IP
- Source | P/Prefix
- Other parameters can be left as default
X please refer to the picture for details of each parameter.
7. Ensure SPAN Destination Group IS tied to an appropriate SPAN Source Group.
8. Ensure Admin State IS Enabl ed.
% SPAN stops when you select Disabled on this Admin state. There is no need to delete all policies
if you re-use them later.

Although it is described in alater section "ERSPAN Version (type)”, you can tell ERSPAN version Il is
used for Fabric SPAN and version | is used for Tenant and Access SPAN.

GUI Verification

TEMANTS. FABRIC

SPa
]
- o)

Erpelegiped Winede- 101 tn_TK_SRC_GRP_DET_GRP_DETA 23 Ensbind -

M
NETWORKING

5 % See Use Case for CLI verification
S0l

ADMSNISTRATIVE STATE OPERATICNAL STATE

Eopologiiped-Unede- 101 tn_TH_SRC_GRP_DST_GRP_DSTA 3 Ensbied w

il VM La-L7 - e e
iare SYSTEM TENANTS e e ADMIN  OPERATIONS fel i n

IHVENTORY |

Lol Session - tn_TK_SRC_GRP_DST_GRP_DST_A

m' opeRATIONAL || HEALTH |[_FauLTs " HISTORY ]
[ 100 |

PROPERTIES
Maené: tn_TK_SRC_GRP_DST_GRP_DST_A
m: 23
Admimistrative State: Enabled
Source IP: 192.168.254.101/ 24
Destinatien IP: 192.168.254.1/32
Fow ID: 1
DSCP: Unspedified
TIL: 64
Typé: Gre encapsilated
Version: Version 1
WHID ID: wxlan-3080192
WEF: TH:VRF1
HTU: 1518
Operatisnal State: Up
Operational State Info: The session is up

Double Click

» Verification of SPAN Configuration Policy

1. Fabric > ACCESS POLICIES > Troubleshoot Policies > SPAN > SPAN Source Groups > Operational tab
2. Fabric > FABRIC POLICIES > Troubleshoot Policies > SPAN > SPAN Source Groups > Operational tab
3. Tenants > { tenant name} > Troubleshoot Policies > SPAN > SPAN Source Groups > Operational tab



Please ensure Operational State is up.
» Verification on SPAN Session on the node itself

1. Double-click on each session from SPAN Configuration PolicyOr Fabric > INVENTORY > Node > Span Sessions > {
SPAN session name }

Please ensure Operational State is up.
SPAN Session naming convention:
- Fabric SPAN: fabric_xxxx

- Access SPAN: infra_xxxx
- Tenant SPAN: th_XxXxxx

Select the ACI SPAN Type

- mm mm mm mm mm mm mm mm mm mm mm = =

:[[ EPG1 ] [ EPG3 ]J [{ EPG2 J[ EPGX ]J,:

LR —

2 _—_-\%_\‘—\h‘-—h_

Dst EPG 192.168.254 1

vlan-755

()

In this section, detailed scenarios are described for each ACI SPAN type (Access, Tenant, Fabric) The base
topology for each scenario is mentioned in the previous section.

If you understand these scenarios, you can select the appropriate ACI SPAN type for your requirement such
as packets on only specific interfaces must be captured or al packets on a specific EPG regardless of
interfaces must be captured, and more.

In Cisco ACI, SPAN is configured with the source group and destination group. The Source group contains
multiple source factors such as interfaces or EPG. The destination group contains destination information
such as the destination interface for Local SPAN or destination |P for ESPAN.

After packets are captured, please see the section "How to Read SPAN Data" to decode captured packets.



Note: Please focus on VMs highlighted with agreen light in each topology. Each scenario isto
capture packets from these highlighted VMs.

Access SPAN (ERSPAN)

Casel. Src"Leaflel/11el/34 & Leaf2 el/11" | Dst " 192.168.254.1"



[ EPG - }

Dst EPG 192.168.254.1

1.-94| |1.-'11'
—

| SRC: 101/1/11,34 2/1

AN il S
vian-T51 vian-752 vlan-753 vlan-754 vlan-755 vlan-756

1 U T T

] o o i i i w
Ve e EPG1 EPG2 EPG3 EPG1

‘_‘—| Source Group '

Destination Group

Fab2-Leafl§ show monitor session all FabZ-Leaf2§ show monitor session all ‘ Fab2-Leaf3§ show monitor session all

® Source Group
- Leaflel/1l
- Leaflel/34
- Leaf2 el/11
® Destination Group
- 192.168.254.1 on EPG X

Access SPAN can specify multiple interfaces for asingle SPAN session. It can capture all packets that come
in or go out from specified interfaces regardless of their EPG.

When multiple interfaces are specified as a source group from multiple Leaf switches, the destination group
must be ERSPAN, not Local SPAN.

In this example, it copies packets from all VMs on EPG1 and EPG2.
CLI Check Point

» Please make sure the statusis "up (active)"
* "destination-ip" 1S destination IP for ERSPAN
* "origin-ip" 1S source |P for ERSPAN

Case2.Src"Leaflel/11 & Leaf2 el/11" | Dst " 192.168.254.1"
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.
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134 [ STt N
Dst EPG 182.168.254.1 (( SRC : 101/1/11 )( SRC : 102/1/11 :] L]
Source Group
Destination Group k — 1 I
vian-T51 vian-752 vlan-753 vian-754 vlan-T55 vian-756
* N MERE
WMs to be captured EPG1 EPG2 EPG3 EPG1

Fab2-Leafl§ show monitor session all Fab2-Leaf2§f show monitor session all Fab2-Leafd§ show monitor session all

» Source Group
- Leaflel/l1l
- Leaf2 el/11
» Destination Group
- 192.168.254.1 on EPG X

In thisexample, Leaf1 €1/34 is removed from the SPAN Source Group configured at previous Casel.
The key point in this example is that Access SPAN can specify source interfaces regardless of EPG.
CLI Check Point

» sourceinterface on Leafl ischanged to "Eth1/11" from "Eth1/11 Eth1/34"

Case3.Src"Leaflel/11 & Leaf2el/11 & EPG1filter" | Dst " 192.168.254.1"



[C__ EPG
A

Dst EPG 192.168.254.1

—

— 1 Source Group

Destination Group

v i

WMs to be captured

Fab2-Leafl§ show monitor session a

F1561 : Failed to configure SPAN with source SRC_A due to Source Epg not available

F1553 : Failed to configure SPAN with source SRC_A due to missingfinvalid EPG
# SPAN on Leafl works

» Source Group
- Leaflel/11
- Leaf2 el/11
- Filter EPG1
» Destination Group
- 192.168.254.1 on EPG X

This example shows that Access SPAN also can specify a specific EPG on the source ports. Thisis useful
when multiple EPGs flow on a single interface and it is required to capture traffic only for EPG1 on this
interface.

Since EPGL is not deployed on Leaf2, SPAN for Leaf2 fails with faults F1553 and F1561. However, SPAN
on Leaf1 still works.

Also, two VLAN filters are automatically added for the SPAN session on Leaf1 because EPG1 uses two
VLANS (VLAN-751,752) on Leaf1.

Please be noted that the VLAN ID on CLI (35, 39) istheinternal VLAN so-called PI-VLAN(Platform
Independent VLAN) which is not the actual ID on the wire. As shown in the picture, show vlan
extended command shows the mapping of the actual encap VLAN ID and PI-VLAN.

This SPAN session allows usto capture packets only for EPG1(VLAN-752) on Leaf1 el/11 even though
EPG2 (VLAN-753) flows on the same interface.

CLI Check Point

» Filter VLANSs are added as per the EPGs that are used for the filter.
* If there are no corresponding EPGs on Leaf, the SPAN session on that Leaf fails.

Case4. Src"Leafl-Leaf2 vPC" | Dst " 192.168.254.1"
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Dst EPG 192.168.254.1

Destination Group

sEate D oup (active)

: 1

i TK:VRFL

B 1}
¢ ip=dscp not

¢ filter not specified

» Source Group
- Leafl - 2el/11
» Destination Group

Fab2-Leafl§ show wvpc extended wpo 2
wEC status

Fod

4083
Fab2-Leafl§ show port-ch axtsndsd int po2 | grep Po

BundleGrp Protocol
UCSh_vEC_1 LACE

Member Ports

Group Port=
z Ethl/&{F)

2 BoZ {30)

Fab2-L4af2ll show vpe extended vpe 2
wEC status

id Port

Endl

Grp Name

504,

5 DCER

vBC 1

4082
Fab2-Leafl§ show port-ch sxtanded int po3 | grep Po
Group Fort- Bundles: Frotocol Member Ports
3 Fo3 {50} UCSR_VPC_1 LACF Ethl/E(F)

- 192.168.254.1 on EPG X

version mot specified
: up (active)
: 1

TR:VEF1

4 ]

: ip-dscp mot specified
: 192.168.254.1/32
254.102/24

origin-ip
mode

source incf :
|5 o : Pol
tx : Pol
both T Pod
source VLANs :
£x
t
bath

filter VLAN: 1 filver not apecified

When the vPC interface is configured as a source, a destination must be remote |P (ERSPAN) not the

interface (Local SPAN)

Access SPAN (L ocal SPAN)

Casel. Src"Leaflel/11e1/34" | Dst " Leafl el/33"

Destination Group

22}

Dst EPG 192.168.254.1

VMs to be captured

DST - 10111133 28

vlan-753 vlan-754

vian-755

wlan-756

¥

EPG2

i

EPG3

>

EPG1

: Span session 14

filter VLANs

destination ports ; Bthl/33

type : local
state 1 up tactive)
mode: : access
source intf :
X : Echl/11 Ethl/34
tx i Echl/11 Ethl/34
both i BEhl/11 Ethl/34
source VIANS z
%
X
both

:+ filter mot specified

itor sessicn all
configured

» Source Group
- Leaflel/l1l

monitor session all
confiqured

Fab2-Leaf3# sho
Note: M




- Leaflel/34
» Destination Group
- Leaflel/33

Access SPAN can aso use Local SPAN (that is a specific interface as a destination)

However, in this case, source interfaces must be on the same Leaf as the destination interface.

Case2. . Src"Leaflel/11el/34 & EPGL1filter | Dst" Leafl e1/33"

)

J

cpr . B
) 104/1/11 34
Dst EPG 192.168.254.1 SRC D 101/11,34
1
@ _:.:;:-_L:__"_:-_- )
vian-T51

vlan-752 vian-753 vian-754 vian-755 vian-T56

-\“1 m‘]
EPG3 EPG1

gl gl g wll il
VMs to be captured EPG1 EPG2

"‘-' Source Group

FabZ-Leaflf§ show menitor sessicn all

FabZ-Leafl§ shew wlan id 35,39 extended

* Source Group
- Leaflel/11
- Leaflel/34
- EPGL Filter
» Destination Group
- Leaflel/33

Access SPAN with Local SPAN can aso use EPG Filter aswell as ERSPAN.

Case3.Src"Leafl el/11 & Leaf2 €/11" | Dst " Leafl €1/33" (bad case)




___________

e, — (R

Dst EPG 192.168.254.1

___________

----------

]

vian-751 vian-752 vian-753 y

vian-755 wlan-756

¥

EPG3

JE3

EET

"“Source GroSerwver Error:400 Spa

an all ‘

» Source Group
- Leaflel/11
- Leaf2 el/11

Unable to configure in the first place

n Fource

not supported”

=> In Local mode, SRC and DST port must be on the same Leaf)

~

and deatination group combination

» Destination Group

- Leaf1el/33

Case4. Src"Leafl el/11 & EPG3filter" | Dst " Leafl €1/33" (bad case)

Dst EPG 192.168.254.1

e

__Snurce Group

133
1 111 11
— : J L ]
vian-751 vian-752 vian-753 vian-754 vian-T55

‘w w\ \< w];’ v |
EPG1 EPG2 | EPG3 |

Fab2-Leafl§ show monitor session all

F1553 : Failed to configure SPAN with source SRC_A due to missing/invalid EPG
F1561 : Failed to configure SPAN with source SRC_A due to Source Epg not available

» Source Group
- Leaflel/l1l
- EPG3 Filter
» Destination Group
- Leaflel/33

It issimilar to case 3 on Access SPAN (ERSPAN) but in this example, the one and only SPAN session on
Leaf1 fails because EPG3 does not exist on Leaf1. So SPAN does not work at all.

Case5: Src"EPG1filter” | Dst " Leafl €l/33" (bad case)



lﬁi;__{éﬁhhﬁeﬁPﬁhy;:C: }

Dst EPG 192.1688.254.1

vian-T55 vian-756

LEMLENCIIEA
EPG1 EPG2 EPG3 EPG1
—\ X

| ‘ Fab2-Leaf2# show monitor l Mo Faults ; Just capture nothing J-,\- monitor session all

e Need to use Tenant SPAN instead of Access SPAN
1 T

» Source Group
- EPG1 Filter
» Destination Group
- Leaf1el/33

EPG filter on Access SPAN works only when source ports are configured. If EPG is the only source to be
specified, Tenant SPAN must be used instead of Access SPAN.

Case6. Src"Leafl - Leaf2vPC" | Dst " Leafl el/33" (bad case)

e ——

=

f pl
L e + wPC cannot be configured with Local Dest port
|

» Source Group
- Leaf1-2 vPC
» Destination Group
- Leaflel/33

A vPC interface cannot be configured as a source with Local SPAN. Please use ERSPAN. Please refer to
cased for Access SPAN (ERSPAN).

Case7.Src"Leafl el/11 | Dst " Leafl e1/33 & €l/33 belongsto EPG" (workswith
fault)



JJ
. 1 1

F1696 : Port has inwvalid configuration of both EPG and span destination
But SPAN itself works

oo ] (Fea” | 5] (o)
EPG1 EPG2 EPG3 EPG1

monitor session all
s configured

R,

Dst EPG 192.168.254.1

vian-751

Fabl-Leafl#l show monitor session all

: Span session 14

type

atate
mode
source intf
% : Bthifil
: Bthl/fil

: Ethl/11

: filter not specified

: Eth1/33

If adestination I/F for SPAN aready belongsto EPG, afault "F1696 : Port has an invalid configuration of
both EPG and span destination" is raised under the physical I/F.

But even with this fault, SPAN works without any problems. Thisfault isjust a warning about extratraffic
caused by SPAN since it can impact customers normal EPG traffic on the same I/F.

Tenant SPAN (ERSPAN)

Casel. Src"EPG1" | Dst "192.168.254.1"

% ERSPAN only
- ! # EPG(=VLAN) filter on whole Leaf
) ] 3% No Interface filter

1z Fol(el
SPAN SRC :
i qﬂ-1'.‘llllll'llllllgilH!!llll'
SRC : EPG1 |

Dst EPG 192.168.254.1

SPAN SRC :
vlan-751, 752

Destination Group

vian-751 vlan-752 vlan-753 wlan-754 vlan-755 vian-758
Vit to be captured EPG2 EPG3 EPG1
FabZ-Leafl§ show monitor session all Fab2-Leaf2§ show monitor session all l Fab2-Leaf3§ show monitor session all
session 15 Note: Wo sessions configured n 1

. Span assaion 15 Fab2-Laafli show vian id 35,39 extendad
: erspan L VIAN Name Status
: version not specified o

: up (active)
: 3

1 THIVRFL

vlan-751
vlan-752

35  enet
33 enet

o

destination-ip

origin-ip

X
both
=ource VLANS H source VLANS
T : 35,39 £ [
tx ¢ 15,39 tx 9
both : 25,39 I both -
filter VIANS : filter not specified 3 filter VLRMN3 : filter not specified

» Source Group
- EPGL1 (nofilter)



» Destination Group
- 192.168.254.1 on EPG X

Tenant SPAN uses EPG itself as a source while Access SPAN use EPG just for afilter.
The key point of Tenant SPAN isthat you do not have to specify each individual port and ACI automatically

detects appropriate VLANSs on each Leaf switch. So this would be useful when all packets for specific EPG
must be monitored and EndPoints for that EPG belong to multiple interfaces across Leaf switches.

Fabric SPAN (ERSPAN)

Casel. Src"Leafl el/49-50" | Dst " 192.168.254.1"

3 ERSPAN only
¥ Capture traffic between Leaf & Spine

- o //f\ ~
Destinatien Group /)‘K
Dst EP(G 192.168.254.1 ‘ / \/ \
5] £ £ Lo | 4.0 ]
\& e ) ' )
] | l

[C EFS J . i |

np el BT g kT P
EPG1 EPG2 EPG3 EPG1

Fab2-Leafl§ show meniter sesaien all FabZ-Leaf2§ show menitor session all ‘ Fab2-Leaf3§ show memitor sessicn all

e Source Group
- Leafl e1/49-50
» Destination Group
- 192.168.254.1 on EPG X

Fabric SPAN specifies Fabric ports as a source where Fabric ports are interfaces between Leaf and Spine
switches.

This SPAN isuseful when it isrequired to copy packets between Leaf and Spine switches. However,
packets between Leaf and Spine switches are encapsulated with iVXLAN header. So it isrequired abit of a
trick to read it. Please refer to "How to Read SPAN Data’.



Note: iIVXLAN header is an enhanced VXLAN header only for ACI Fabric internal use.

Case2. Src"Leafl el/49-50 & VRF filter" | Dst " 192.168.254.1"



Destination Group

Dst EPG 192.168.254.1

R —

[ EPG /7___]

Fab2-Leafl§ show monitor session a

» Source Group
- Leafl e1/49-50
- VRF Filter
» Destination Group
- 192.168.254.1 on EPG X

Fabric SPAN can usefilters aswell as Access SPAN. But thefilter type is different. Fabric SPAN uses
Virtual Routing and Forwarding (VRF) or BD as afilter.

In Cisco ACI, as described before, packets that go through Fabric ports are encapsulated with iVXLAN
header. ThisiVXLAN header has VRF or BD information as Virtual Network Identifier (VNID). When
packets are forwarded as Layer2 (L2), iVXLAN VNID stands for BD. When packets are forwarded as
Layer3 (L3), iVXLAN VNID standsfor VRF.

So when it isrequired to capture routed traffic on Fabric ports, use VRF as afilter.

Case 3. Src " Leafl el/49-50 & BD filter" | Dst " 192.168.254.1"



Destination Group

Dst EPG 192.168.254.1

AN
SRC : BD1
SRC : 101/1/49-50

e —

DST

X 192.168.254

N

Y

EPG3

v v

EPG2

K §

EPG

¥

EPG1

Fab2-Leaflf show monitor session all
session 17

description ! Span session 17
Type 1 erspan

versien 2

state

t up (active)
erspan=-id b |
granularity :
: TK:VRF1

wEL-name
T

ip-dse : ip-dsep not specified
destination-ip 1 192.168.254.1/32
origin-ip i 192.166.254.101724
mode : fabric
socurce intf z

3 : Ethl/48 Ethl/50

% : Eth1/49 Ethl/50

bBath : Bthl/49 Ethl/50
source WLANS :

=

tx

bBath

filter VLANS

: wxlan-16187318, vxlan-3080192

Fab2-Leaf2§ show monitor session all

Note: Mo sessions configured

FabZ-Leafl§ show monitor session all

Mete: Mo sessions configured

Fab2-Leaflf show vrf TH:VRAFl detail extended
VRF-Hame: TK:VRFl, VRF-ID: 4, State: Up
VENID: unkmown
RO 10.0.152.582:1
Max Routes: 0 Mid-Thresheld: 0
Encap: wxlan-3030132
Table-ID: 0x30000002, AF: IPvé, Pwd-ID: Ox80000002, State: Up
Table-I0: Ox00000002, AF: IFvd, Fwd-ID: Ox00000002, State: Up
Fab2-Leaflff show vlan id 17 extended
VLAN Mame Status Ports
17 TH:BDL active Ethl/5, Ethl/€., Ethl/fl1,
Ethl/34, FoZ, Po3
VIAN Type WVlan-mode Encap
17 enet vxlan-16157218

» Source Group
- Leafl el/49-50
- BD Filter

* Destination Group

- 192.168.254.1 on EPG X

Asdescribed in previous case 2, Fabric SPAN can use BD as afilter.

When it isrequired to capture bridged traffic on Fabric ports, use BD as afilter.




Note: Only asinglefilter of either BD or VRF can be configured at atime.

What do you need on the SPAN destination device?

Just run a packet capture application such as tcpdump, wireshark On it. It is not required to configure the
ERSPAN destination session or anything.

For ERSPAN

Please ensure to run a capture tool on the interface with the destination IP for ERSPAN since SPAN packets
are forwarded to the destination IP.

The received packet is encapsulated with a GRE header. Please refer to this section "How to Read ERSPAN
Data" on how to decode the ERSPAN GRE header.

For Local SPAN

Please ensure to run a capture tool on the interface that connects to the SPAN Destination interface on ACI



Leaf.

Raw packets are received in thisinterface. it is not required to deal with the ERSPAN header.

How to Read ERSPAN Data

ERSPAN Version (type)

ERSPAN encapsulates copied packets to forward them to the remote destination. GRE is used for this
encapsulation. The protocol type for ERSPAN on the GRE header is 0x88be.

In Internet Engineering Task Force (IETF) document, the ERSPAN version is described as type instead of
version.

There are three types of ERSPAN. I, Il and 111. ERSPAN Type is mentioned in this REC draft. Also, this
GRE RFC1701 can be helpful to understand each ERSPAN type as well.

Here is the packet format of each type:

ERSPAN Typel (used by Broadcom Trident 2)

Ethernet IP GRE Ethernet IP

Payload
header header header header header y

0 ] 2 3
0123456789501 234567890123456789%°01
s s T e e e A e e T e e et L

[0O10101010100000]000000000100000] Protocol Type (0x88be=ERSPAN)
s e e S e e e D LS L D P B e LT
GRE HEADER : 0x0000 88be

Type | does not use the sequence field on the GRE header. It does not even use the ERSPAN header which
must succeed the GRE header if it was ERSPAN type Il and I11. Broadcom Trident 2 only supports this
ERSPAN typel.

ERSPAN Typell or Il

Ethernet IP GRE ERSPAN Ethernet P
header header header header header header

Payload

If the sequence field is activated by the S bit, this must be ERSPAN type Il or I11. The version field on the
ERSPAN header identifies the ERSPAN type. In ACI, type Il is not supported as of 03/20/2016.

If a SPAN source group for Access or Tenant SPAN has sources on both 1st-gen and 2nd-gen nodes, the
ERSPAN destination receives both ERSPAN Type | and Il packets from each generation of nodes.


https://datatracker.ietf.org/doc/html/draft-foschiano-erspan-00
https://www.rfc-editor.org/rfc/rfc1701

However, Wireshark can decode only one of the ERSPAN Types at atime. By default, it only decodes
ERSPAN Typell. If you enable the decode of ERSPAN Type I, Wireshark does not decode ERSPAN Type
I1. See the later section on how to decode ERSPAN Type | on Wireshark.

To avoid this type of issue, you can configure ERSPAN Type on a SPAN destination group.

Policies SPAN Destination Group - SPAN_DST

» (C» Quick Start
o — e
> [ Modules

» [ Interfaces

- [l Policies Name: SPAN_DST
> [l Switch Description: | optiona
» [ Interface
? = Global Destination EPG: ynilin-SPAMN/ ao-AR epg-SEAN

> [ Monitoring SPAN Version: |

.
» [l Troubleshooting Enforce SPAN Version: []
o SPAN Destination IP: | 8

~ [ SPAN Source Groups Source IP/Prefix: |1.0.0.0/8

> B sRci Flow ID: |1 o
> [l SPAN Filter Groups TTL: |64 o
- [ SPAN Destination Groups MTU: | 1518 >

B sPan_DsT DSCP: | Unspecified

* SPAN Version (Version 1 or Version 2): Thisrefersto the ERSPAN Typel or |1
» Enforce SPAN Version (checked or unchecked): This decidesif the SPAN session must fail in case
the configured ERSPAN Typeis not supported on the source node hardware.

By default, SPAN Versionis Version 2 and Enforce SPAN Version is unchecked. This meansthat if the
source node is 2nd gen or later which supports ERSPAN Type I, it generates ERSPAN with Type ll. If the
source node is 1st gen which does not support ERSPAN Type |1 (except for Fabric SPAN), it falls back to
Type | since the Enforce SPAN Version is not checked. As aresult, the ERSPAN destination receives a
mixed type of ERSPAN.

Thistable explains each combination for Access and Tenant SPAN.

SPAN Enforce SPAN

Version |Version 1st gen sour ce node 2nd gen sour ce node

Version 2 {Unchecked Uses Typel Uses Typell

Version 2 |Checked Fails Uses Typell




Version 1 {Unchecked Uses Typel Uses Typel

Version 1 |Checked Uses Typel Uses Typel

ERSPAN Data Example

Tenant SPAN/Access SPAN (ERSPAN)

[CEPG."E

g}

Dst EPG 192.168.254.1

|

vian-751 vian-752 wian-753 wian-754 vian-T55 vian-T56
gl <> > gl wll il
35 " ?.1 1 *P " 02 b b
EPG1 EPG2 EPG3 EPG1
182.168.1.0/24 182.168.2.0/24

[rootfcentosd ~1# topdump -i ethl not arp -w AcoessERSPAN.poap T I5ource [Destination |
1 0.000000 192.168.2.2 192,168,2.254 TCMP 140 Eche (ping) request
[rooticantosd -1} topdump -r AccessERSEMN.pcap 2 0.000113 192.168.2,254 192,168.2.2 ICHP 140 Echo {(ping) reply
reading from file ERSPAN.F nk-type EN 3 0.350976 192.168.2.1 192.168.2.254 ICMP 140 Echo {ping) request
x 4 0.351100 192.168.2.254 192.168.2.1 ICMP 140 Echo {ping) reply
e 5 0.365184 192.168.1.35 192.168.1.254 ICMP 140 Echo (ping) request
& 6 0.365312 192.168.1.254 102.168.1.35 ICMP 140 echo (ping) reply
- 7 0.627012 192.168.1.1 102.168.1.254 IcMP 140 Echo (ping) request
3t B 0.628035 192.168.1.254 102.168.1.1 ICMP 140 Echo {ping) reply
. 9 1.000038 192.168.2.2 192.168,2.254 1CMP 140 Echo (ping) request
N 10 1.000083 192.168.2.254 192.168.2.2 ICMP 140 Eche {ping) reply
, it enEed Iencth 10E: ChecOiotoodal 11 1.3522%4  192.168.2.1 192.168.2.254 ICMP 140 Echo {ping) request
o ) ) 12 1.352417 192.168.2.254 192.168.2.1 ICMP 140 echo (ping) reply
¥ ERSPAN = GRE encap'ed packet = Src/Dst are GRE IP 3 After decode it on Wireshark = real IPs are shown
# 192.168.254.101 = from node-101 % See How to Decode ERSPAN Type 1 on Wireshark

# "not arp” : suppress arp for ERSPAN src from capture machine (may not need)

Packets need to be decoded since it is encapsulated by ERSPAN Type I. This can be done with Wireshark.
Please refer to the section "How to Decode ERSPAN Type 1".

Details of Captured Packet (ERSPAN Typel)

0000 88be

Fabric SPAN (ERSPAN)



Fiter: |.p.m--m.a.1q2.92 j:xpm._. Clear  fonly  Save

26 0.184754 10.0.182.92
T 10

10.0.32.66 UDP 198 Source port:
0 10.0 16 G
10,0,192,92

UCP 19 Irce port:

7248 Destination port: 4867%
10.0.32.65 upP 160 Source port: 52672 DesTination port: 48879

3z 0.

) ) 262735
ERSPAN Type 2 is automatically decoded 34 0,262855  10.0.192.92 239,255.255.255 UDP 156 Source port: 38745 pestination port: 48879
by Wireshark 35 0.262868 10.0.192.92 239.255.255.255  UDP 156 Source port: 38745 Destination port: 48879
Y 38 0.263458  10.0.192.92 225.0.213.250 UoP 160 Source port: 43738 Destination port: 48879
3 be noted that this is still iVxLAN header 148 0.768367 10.0.0.1 10.0.192.92 TCP 116 56210-12151 [AcK] Seqml Ack=l Win=770 Len=Q °
152 0.856142 10.0.192.92 225.0.213. 248 UupP 164 Source port: 45334 Destination port: 48879
234 1.185477 10.0.192.92 10.0.32.66 uoP 198 source port: 7248 pestination port: 48879
235 1.185606  10.0.192,95 10.0.192.92 uoP 198 Source port: 25158 bestination port: 48879
253 1.250119  10.0.192.92 10.0.0.1 TP 116 57294-12375 [AcK] Seqel Acke=l Win=270 Lens0

Wireshark automatically decodes ERSPAN Type I1. However, it is still encapsulated by iVXLAN header.

By default, Wireshark does not understand the iVXLAN header sinceit is ACI internal header. Please refer
to "How to Decode iVXLAN Header".

Details of the Captured Packet (ERSPAN Typell)

1000 88be 0000 4054 1002 1001 0001

How to Decode ERSPAN Typel

Option 1. Navigate to Edit > Preference > Protocols > ERSPAN and check FORCE to decode the fake ERSPAN
frame.

» Wireshark (GUI)



7\!\!1resharlc Preferences - Profile: Default - N - - -~e - — —r]

DVB-C1 <
Dwve-52
DVMRP
EDOMKEY
ELF

ENIP
ENTTEC
EPL

ERF

ESL

ESP

ESS

Etch

FORCE to decode fake ERSPAN frame: ¥

(T

Ethernet
EVRC
EXEC

FC

FCGI
FColB
FDODI

Fibre Channel over IP

[ ok [ aeey | [ concel ]

» Tshark (CLI version of Wireshark):

userl@linux# tshark -f 'proto GRE' -nV -i ethO -o erspan.fake_erspan:true



Note: Please ensure to disable this option when you read ERSPAN typell or IIl.

Option 2. Navigate to Decode As > Network > ICMP (if it's ICMP).



r M Wireshark: Decode As Em

Decode |Lin|-t Metwork
Do not decode GRE 7

HIP
ICMPvb |
IGMP

| IGRP

IPComp
| Show Current | >

—

IP protocol 47 as

| Clear

Mk sA

[ Help ‘ OK | Apply || Close ]

How to DecodeiVxL AN Header

. E=EET%

File Edit View Go Capture Analyze Statistics Telephony ] ] ] )

COAMI BREXD XAesaF L ([ * 0ecoce Link | Network| Link| Network| Transport | _
— ! Do not decode UNISTIM =

No.  Time Source WEHD
14 ZUL>=1U=£3 Z3I42 100U, YUD 398 u.u.u. 4 Vines FRP k I‘:I:J_‘IJ_ Len=u 1:
15 2015-10-23 23:25:00.905402 10.0.0.2 Win=331 Len=0 1
16 2015-10-23 23:25:00.905405 10.0.0. UDP destination (—48879) El port(s) as MITA 48 Win=331 Len=0
17 2015-10-23 23:25:00.905484 10.0.0. Vuze-DHT =151 win=331 L
18 2015-10-23 23:25:00.905497 10.0.0. D win=331 Len=(
19 2015-10-23 23:25:00.905964 10.0.0.2 Clear 55 wWin=331 L¢
20 2015-10-23 23:25:00.906111 10.0.0-3| [ show Current | WASSP - k=200 win=331
21 2015-10-23 23:25:00.945693 10.0.0. “I6 Win=331 Lens=(
22 2015-10-23 23:25:00.945709 10500 Win=331 Len=0
23 2015-10-23 23:25:00.945830 10.0. 0. 7| sbiciess Lok J[ aeey [ gese |QNCc 5301
24 2015-10-23 23:25:00.945927 10.0.0.1 TO U0 Z TCP TIU LZJ07=38322 Win=331 Len=(
25 2015-10-23 23:25:00.946480 10.0.0.1 10.0.0.2 TCP 161 12567-+58322 [PSH, .&CK] seq= 155 Ack=200 win=331
26 2015-10-23 23:25:00.962085 10.0.192.92 10.0.32.66 uppP 198 Source port: ?248 Destination port: 48879
27 2015-10-23 23:25:00.962224 10.0.192.95 10.0.192.92 uppP 198 Source port: 25168 Destination port: 48879
28 2015-10-23 23:25:00.986492 10.0.0.2 10.0.0.1 TCP 116 58322-12567 [ACK] Seq=200 Ack=200 Win=331 Lens=(
29 2015-10-23 23:25:01.039557 10.0.0.3 10.0.0.1 TCP 166 50193-12567 [PSH, ACK] Seg= 196 Ack—ZGO win=331
30 2015-10-23 23:25:01.039671 10.0.0.1 10.0.0.3 TCP 116 1256750193 [ﬁ.(i(] Seq=200 _Ack=248 Win-331 Len=(
31 2015-10-23 23:25:01.039933 10.0.0.3 10.0.0.1 TCP 1415 50193-+12567 [PSH, Af eq=246 Ack=200 “Eal
32 2015-10-23 23:25:01.040066 10.0.192.92 10.0.32.65 uppP 160 Source port: 6267 Destination port: 48879
33 2M5-10-23 23:25:010. 040079 10.0.0.1 10.0.0.3 TCP 116 1256750193 TACK] SM ) Ack=1545% Win= ens:

4 m

iIVXLAN header uses destination port 48879. So, you can decode iVXLAN header aswell as VXLAN if you
configure UDP destination port 48879 as VXLAN on Wireshark.

1. Please ensure that you select iVXLAN encapsulated packets first.
2. Navigate to Analyze > Decode As > Transport > UDP destination (48879) > VXLAN.
3. And then Apply.



Note: There are communication packets between APICs on Fabric ports. Those packets are not
encapsulated by iVXLAN header.

When you take an erspan capture on a user network that runs Precision Time Protocol (PTP) sometimesitis
seen that Wireshark does not interpret the data due to an unknown ethertype within the GRE encap
(Ox8988). 0x8988 is the ethertype for the time tag that is inserted into dataplane packets when PTPis
enabled. Decode the ethertype 0x8988 as " Cisco ttag" to expose the details of the packet.



4 Y Y Y YYVYVYY

Frame 25280: 182 bytes on wire (1456 bits), 182 bytes captured (1456 bits) on interface @
Ethernet II, Src: Cisco_f8:19:ff (09:22:bd:f8:19:ff), Dst: Dell_4b:a8:cf (ad:d4c:c8:4b:a8:cf)
Internet Protocol Version 4, Src: 1.0.0.104, Dst: 172.30.32.7
Generic Routing Encapsulation (ERSPAN)
Encapsulated Remote Switch Packet ANalysis
Ethernet II, Src: Itsuppor_ @d:@d:@d (90:0d:0d:@d:0d:@d), Dst: ApproTec @c:@c:@c (0@:0c:@c:@c:0c:0c)
Internet Protocol Version 4, Src: 100.80.0.69, Dst: 180.68.160.65
User Datagram Protocol, Src Port: 31327, Dst Port: 48879
Virtual eXtensible Local Area Network
» Flags: @xcB38, GBP Extension, VXLAN Network ID (VNI), Policy Applied
Group Policy ID: 49203
VXLAN Network Identifier (WNI): 14974940
Reserved: 128
Ethernet II, Src: Cisco_c9:10:80 (lc:df:@f:c9:10:80), Dst: 54:bf:64:26:89:24 (54:bf:64:a6:89:24)
¥ Destination: 54:bf:64:26:89:24 (54:bf:64:36:89:24)
<[Destination (resolved): 54:bf:64:a6:89:24]>
Address: 54:bf:64:a6:89:24 (54:bf:64:a6:89:24)
<[Address {resolved): 54:bf:64:a6:89:24]>
eoss 2s®s sess sess ssss wess = LG bit: Globally unique address (factory default)
sias s24@ suis sees savs sess = 16 bit: Individual address (unicast)
¥ Source: Cisco_c9:10:80 (1c:df:@f:c9:10:88)
<[Source (resolved): Cisco_c9:10:80]=>
Address: Cisco_c9:10:80 (lc:df:0f:c9:10:80)
<[Address (resolved): Cisco_c9:10:8@]>
ver ee@u vuie wews esve wees = LG bit: Globally unique address (factory default)

vs waes = IG bit: Individual address (unicast)
Type: Unknown (@xB988)

Data (68 bytes]
Data: fea691a6d34908004500003cbaaddeeafial9983a1874141, ..
[Length: 68]




